
END USER LICENSE AGREEMENT

IMPORTANT - CAREFULLY READ THE FOLLOWING TERMS AND CONDITIONS
OF THIS AGREEMENT. This End User License Agreement (“Agreement”) is a legal
agreement between you, the user of Philips’ portable computing device (“Product”),
and Philips Mobile Computing Group (“Philips”), the manufacturer of the Product.
The Product came with certain software products, and associated documentation,
which are installed on the Product and/or included in the original Product packaging
on external media. (All such software and documentation are collectively referred to
as “Software”.) BY INSTALLING, COPYING, OR OTHERWISE USING THE
SOFTWARE YOU ARE AGREEING TO BE BOUND BY THE TERMS OF THIS
AGREEMENT. IF YOU DO NOT AGREE TO THE TERMS OF THIS AGREEMENT,
PHILIPS IS UNWILLING TO LICENSE THE USE OF THE SOFTWARE TO YOU.
IN SUCH EVENT, YOU MUST NOT OPEN THE SEALED PRODUCT OR
SOFTWARE AND MUST PROMPTLY RETURN THE SEALED PRODUCT AND

SOFTWARE TO THE PLACE YOU OBTAINED IT FOR A FULL REFUND.

1. Grant of License. Philips hereby grants you the non-exclusive right to use the
Software only as installed on the Product or, for Software which is not already
installed on the Product, to install and use the Software on a single Product.

2. Ownership of the Software and Documentation. You do not receive title or
ownership to the Software, but merely the limited right to use the Software as
specified in this Agreement.

3. Restrictions. You may not: (i) copy the Software except for one copy for back-up,
archival purposes provided that the copy contains all of the original Software’s
proprietary notices and is subject to all of the terms of this Agreement; (ii) modify,
translate, reverse engineer, decompile, disassemble (except to the extent that this
restriction is expressly prohibited by law) the Software or create derivative works
based upon the Software; (iii) rent, lease, lend, or sublicense the Software; (iv) or
transfer the Software except together with the sale or transfer of the Product and then
only if you keep no copy of the Software, if you transfer all of the Software
(including backup copies), and if the recipient agrees to comply with, and be bound
by, the terms of this Agreement.

4. Termination. This Agreement, and the licenses granted in it, is effective until
terminated. This Agreement will terminate: (i) automatically if you fail to comply
with the terms of this Agreement; or (ii) without prejudice to any other rights, upon
written notice sent to you by Philips if Philips, in its sole judgment, believes that the
Software is being used for a purpose not approved by it or that its rights are being
jeopardized. In such event, you must destroy all copies of the Software and all of its
component parts immediately upon receipt of such notice.

5. Limited Warranty

a. For a period of one (1) year from the date of purchase by you, Philips warrants that
the Product, excluding Software, shall function in substantial conformance with the
performance requirements set forth in the end-user documentation under normal use
and shall be free from defects in materials and/or workmanship.

b. For a period of ninety (90) days from the date of purchase by you, Philips warrants:
(i) that the Software in object code in the Product ROM (or on the removable storage
device (“Miniature Card”) to be inserted in the miniature card socket of the Product, if
applicable) shall function in substantial conformance with the performance
requirements set forth in the end-user documentation under normal use; and (ii) that
the media on which such Software is furnished shall be free from defects in materials
and/or workmanship.



c. For a period of thirty (30) days from the date of purchase by you, Philips warrants:
(i) that the Software in object code form on all external media shall function in
substantial conformance with the performance requirements set forth in the end-
user documentation under normal use; (ii) and that the media on which such
Software is furnished shall be free from defects in materials and/or workmanship.

d. This Limited Warranty does not apply to the finish or cosmetic appearance of the
Product.

e. This Limited Warranty is provided only to you, the original purchaser of the
Product. It is not transferable by you to any other person or entity.

f. This Limited Warranty is void if failure has resulted from accident, abuse, or
misapplication. Without limiting the foregoing, battery leakage, bending of the unit,
a broken LCD display or any cracks in the LCD display will be presumed to have
resulted from misuse or abuse.

g. Your sole and exclusive remedy in the event of a breach of warranty shall be, at
Philips’ option, the replacement of the Product or the Software with a
remanufactured or refurbished Product or refund of the price you paid, provided
you return the Product to Philips together with a copy of your receipt.

6. Warranty Disclaimer / Limitation of Liability.

a. EXCEPT AS SPECIFICALLY SET FORTH ABOVE, PHILIPS DISCLAIMS ALL
WARRANTIES, INCLUDING WITHOUT LIMITATION, THE IMPLIED WARRAN-
TIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE.

b. PHILIPS SHALL NOT BE LIABLE FOR ANY LOSS OF USE, DAMAGES RESULT-
ING FROM MATHEMATICAL INACCURACY, LOSS OF STORED DATA, OR
INDIRECT OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR
INABILITY TO USE THE PRODUCT OR ANY SOFTWARE EVEN IF PHILIPS HAS
BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. IN NO EVENT
SHALL PHILIPS’ LIABILITY EXCEED THE COST OF THE PRODUCT,
WHETHER YOUR CLAIM IS BASED ON CONTRACT, TORT, WARRANTY, OR
ANY OTHER LEGAL THEORY. SOME STATES OR JURISDICTIONS DO NOT
ALLOW THE EXCLUSION OR LIMITATION OF IMPLIED WARRANTIES OR
LIMITATION OF IMPLIED WARRANTIES OR LIABILITY FOR INCIDENTAL OR
CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATIONS MAY NOT APPLY
TO YOU.

7. Microsoft Software. This Agreement does not apply to Microsoft software. Your
rights to use, and restrictions on, Microsoft software are governed by a separate
end user license agreement which applies exclusively to Microsoft software.

8. U.S. Government Restricted Rights. Pursuant to DFARS 227.7202 and FAR
12.212, the Software is subject to, and restricted by, this Agreement. Use,
duplication, or disclosure by the United States Government is governed solely by
the terms and conditions contained herein.

9. Choice of Law. This Agreement is governed and construed under the laws of the
State of California, except those portions pertaining to conflicts of law. You consent
to the exclusive jurisdiction of the state and federal courts sitting in the State of
California.

10. Entire Agreement. This Agreement constitutes the entire agreement with you
concerning the Software. It may not be amended or altered except in a written
document signed by you and an authorized representative of Philips.
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Introduction

The Philips Velo™ 1 is a handheld PC (H/PC), a kind of computer
that you can carry with you and use almost anywhere. It allows you
to keep track of your appointments, take files with you, send and
receive e-mail, connect to the World Wide Web, and much more.

Your package includes the following compact discs:

◗ The Microsoft® Windows® CE compact disc. This CD
contains Windows CE® Services 2.0 with ActiveSync™
software for your desktop computer. With Windows CE
Services, you can browse the contents of your Velo 1 from
your desktop computer using My Computer or Windows
Explorer. ActiveSync enables you to synchronize files and
e-mail messages, as well as PIM data, and offers continuous
background synchronization. The Windows CE Services
compact disc also includes optional system extensions for
Windows 95 or Windows NT® and optional Microsoft
programs for your Velo 1.

◗ The Philips Velo 1 Upgrade compact disc. This disc
includes programs and components of the Velo 1 applica-
tions and operating system.

Important: You’ll need to install the software on both of these CDs.
Instructions for installing the software on these discs are provided in this
booklet.

This booklet is designed to get you up and running with your Velo 1
as quickly as possible. It also provides a brief overview of the
operating system features and programs.

For additional help with installation, contact Philips technical support
at 1-888-275-8356, or visit Philips on the World Wide Web at:
www.mobile.philips.com.

For help with using your Velo 1, see the specific topics in Windows
CE Services online Help and the Velo 1 online Help. For a more
detailed description of the operating system, download the Microsoft
Windows CE Guided Tour from Microsoft’s Web site
(www.microsoft.com/WindowsCE).
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Installing the Windows CE upgrade requires
these steps:

1 Set up your Velo 1 for the upgrade.

If you purchased the Microsoft Windows CE 2.0
Upgrade Kit, follow the steps on page 8.

If you purchased the Velo 1 with 12 MB of DRAM and
the Microsoft Windows CE Upgrade Card already
installed, follow the steps on page 13.

2 Install Windows CE Services 2.0 (from the Microsoft
Windows CE CD) on your desktop computer.

3 Prepare your Velo 1 and your desktop computer for
installing Velo 1 applications.

4 Install Velo 1 applications (from the Velo 1 Upgrade CD)
onto your Velo 1.

5 Retrieve your Velo 1 data (only if you purchased the
Upgrade Kit and saved your data in Step 1).

Introduction
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Step 1:  Set Up Your Velo 1 for the Upgrade

Important: If you purchased the Velo 1 with 12 MB of DRAM and
the Microsoft Windows CE 2.0 Upgrade Card already installed, go to
page 13.

If you purchased the Microsoft Windows CE 2.0 Upgrade Kit, you
will complete these steps:

• Save your Velo 1 data
• Remove all the batteries from your Velo 1.
• Install the Windows CE 2.0 ROM Miniature Card.
• Install more RAM in your Velo 1.
• Reinsert all the batteries.

1a: Save your Velo 1 data.

Before you install the Windows CE 2.0 ROM Miniature Card, you
must back up all data on your Velo 1. When you install the ROM
Miniature Card, all programs, settings, files, and PIM data
(Calendar, Contacts, and Tasks information) on your Velo 1 will be
erased. Many of these items cannot be restored from a
backup file unless you follow the procedures below, which
explain how to back up all information on your Velo 1 to ensure
that no data is lost. After you have installed the upgrades on both
your Velo 1 and desktop computer, you will restore your data as
described in “Step 5: Retrieve Your Data.”

Programs — After you complete the upgrade, you will need to
reinstall any programs you’ve added to your Velo 1 from the
original source. In some cases, existing programs may not be
compatible with Windows CE 2.0. Check with the program’s
manufacturer to find out if you need a new version.

Settings — Program and device settings will be lost during the
upgrade. Before you upgrade, write down any important settings,
such as TCP/IP and network settings for remote connections,
settings for Inbox services, alarms and reminders, desktop
patterns, and sound schemes.
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Files — Documents and data files can be backed up using H/PC
Explorer; however, because Windows CE 2.0 and its components
require more storage memory than the original version, you may not
have enough memory to complete the upgrade. To ensure that
no data is lost, you should back up or copy individual files,
including data on a flash miniature card, if you have one,
onto your desktop computer.

To back up individual files
1 On your desktop computer, create a new folder in which

to save the backed-up files.

2 Connect your Velo 1 to your desktop computer, and start
H/PC Explorer.

3 In H/PC Explorer, select the files and folders you want to
back up, and drag them to the folder you created, or use
the Cut and Paste commands to move the files from your
Velo 1 to the backup folder.

PIM data — PIM data can be preserved by synchronizing your
Velo 1 with Microsoft Schedule+ or Microsoft Outlook™ on your
desktop computer immediately before upgrading.

To synchronize PIM data
1 Connect your Velo 1 to your desktop computer and start

H/PC Explorer.

If you have set H/PC Explorer to synchronize on
connecting, synchronization will take place automatically.

2 If you have not set H/PC Explorer to synchronize on
connecting, in H/PC Explorer on your desktop computer,
click Synchronize Now on the Tools menu.

Step 1: Set Up Your Velo 1 for the Upgrade
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Mail messages — If you have Microsoft Exchange or Outlook on
your desktop computer, transfer important messages to the Inbox
on your desktop computer, using the Inbox Transfer extension in
Exchange or Outlook.

To transfer mail messages
1 Connect your Velo 1 to your desktop computer, and start

H/PC Explorer.

2 In Microsoft Exchange or Outlook on your desktop
computer, click H/PC Inbox Transfer on the Tools
menu.

3 Under Transfer messages from your H/PC, select the
messages you want to save.

4 Click OK.

5 Select a folder to transfer messages to, or click New
Folder create a new folder.

Note:  The original dates and times of the messages you
transfer will be changed to the date and time the at which
messages were transferred.

1b: Remove the main battery (or batteries)
and the backup battery from your Velo 1.

Important:   You must remove all batteries before you install the
Windows CE 2.0 ROM Miniature Card. If you don’t, the upgrade will
not work properly.

1c: Install the Windows CE 2.0 ROM Miniature
Card.

Warning:   When you install the Windows CE 2.0 ROM Miniature
Card, all information on your Velo 1 will be erased. Before you install
the ROM Miniature Card, back up all information by following the
procedures described in the previous section, “Save your Velo 1 data.”
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To install the Windows CE 2.0 ROM Miniature Card
1 Back up all files on your Velo 1 as described above.

2 Turn off your Velo 1.

3 On the bottom of your Velo 1, slide back the latch to
release the door to the Flash/ROM Miniature Card slot and
remove the door to the slot and the dummy card or Flash
Card.

4 Insert the ROM Miniature Card into the slot, and push the
card down until it snaps into place.

5 Replace the door.

Step 1: Set Up Your Velo 1 for the Upgrade
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Note: Do not remove the Windows CE 2.0 ROM Miniature Card
from the Flash/ROM Miniature Card slot. After you install the ROM
Miniature Card, you will be unable to use the Flash/ROM Miniature
Card slot for other cards, such as flash memory upgrades or programs
that come on Miniature Cards.

1d: Install more RAM in your Velo 1.

If you do not have 12 MB of RAM installed on your Velo 1 you
will need to install enough RAM to bring your device up to 12
MB in order to proceed with the upgrade.

1 Take your Velo 1 out of the Velo Dock.

2 Remove the screw from the DRAM Miniature Card slot
and remove the slot door.

3 If there is a card (or a plastic dummy card) already in the
slot, remove it.

4 Insert the 8 MB DRAM Miniature Card in the slot by
pushing down the card until it snaps into position.

5 Replace the door and the screw.

1e: Follow the steps below and reinsert the
main battery (or batteries) and the backup
battery.

1 Plug the supplied AC adapter into your Velo 1 and a wall
outlet.

2 Press the Power button to turn on the Velo 1.

3 The Welcome Wizard appears; ignore it for now.

4 Unplug the AC adapter from the Velo 1.

5 Insert the main battery and the backup battery. (See the
figures on page14.)

6 Plug the AC adapter into the Velo 1.

7 Press the Power button to turn on the Velo 1.

8 Tap  to close the Expansion Memory Detected dialog
window.

After you reinsert the batteries, go to “Step 2: Install Windows CE
Services 2.0 on Your Desktop Computer” on page 15.
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Step 1: If you purchased the Velo 1 with 12 MB
of DRAM and the Microsoft Windows CE 2.0
Upgrade Card already installed, start here:

1 Plug the supplied AC adapter into your Velo 1 and a wall
outlet.

2 Press the Power button to turn on the Velo 1.

3 The Setup Wizard appears; ignore it for now.

4 Unplug the AC adapter from the Velo 1.

5 Insert the main battery and activate the backup battery.
(See the figures on the next page.)

a Slide the main battery door lock.
b Open and detach the battery door.
c Pull out the yellow plastic tab and discard it.

(This step activates the backup battery.)
d Insert the NiMH rechargeable battery pack.
e Replace the battery door.

6 Plug the AC adapter into the Velo 1.

7 Press the Power button to turn on the Velo 1.

8 Tap  to close the Expansion Memory Detected dialog
window.

Step 1: Set Up Your Velo 1 for the Upgrade
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Bottom of Velo 1

-
+

Bottom view showing rechargeable battery pack insertion
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Step 2: Install Windows CE Services 2.0
On Your Desktop Computer

System requirements

The minimum PC requirements for running Windows CE Services 2.0
are as follows:

◗ Microsoft Windows NT® Workstation 4.0 or Windows 95

◗ Desktop computer with a 486/33DX or higher processor
(Pentium P90 recommended)

◗ 12 MB of memory for Windows NT Workstation 4.0

◗ 8 MB of memory (12 MB recommended) for Windows 95

◗ Hard disk drive with 10 to 50 MB of available hard-disk
space (actual requirements will vary, based on selection of
features and current system configuration)

◗ Available 9- or 25-pin communications port (25-pin port
requires adapter)

◗ CD-ROM drive

◗ VGA or higher-resolution graphics card (Super VGA
256-color recommended)

◗ Keyboard

◗ Microsoft Mouse or compatible pointing device

In addition, the following optional system components will allow
you to use certain features of Windows CE Services:

◗ Audio card and speakers for sound

◗ Microsoft Office 97 or Microsoft Office 95

◗ Serial or built-in infrared adapter for synchronization

◗ Modem for remote synchronization

◗ Ethernet LAN connection for remote synchronization

Step 2: Install Windows CE Services
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In addition to Windows CE Services 2.0, the Microsoft Windows CE
compact disc contains Microsoft Schedule+, updates to the Windows
Messaging System (Microsoft Exchange), and Windows 95 Dial-Up
Networking and some optional items. The installation program will
check for and install these components as necessary to ensure that
you can set up and run Windows CE Services 2.0, as well as
applications including Pocket PowerPoint® and Pocket Streets.

Installing Windows CE Services 2.0

The Windows CE Services 2.0 installation program includes several
steps. The steps you follow depend on your operating system
(Windows 95 or NT) and system configuration. When you run Setup,
it tests for installed components and prompts you to install only
those components you need. To ensure that you install all the
necessary components, simply click each button in order on the
Setup screen. You may be instructed to restart your computer
several times during the installation procedure.

To install Windows CE services on your desktop computer, follow
these steps:

1 Insert the Microsoft Windows CE compact disc in a CD-ROM
drive on your desktop computer.

Setup begins automatically. If Setup does not begin
automatically, click Run on the Start menu, then type d:setup
(where d: is the letter of the drive containing the Microsoft
Windows CE CD) and press Enter.

2 Follow the instructions on your screen to complete installation.

3 When the “Get Connected” dialog box appears, click Cancel.
Proceed to Step 3 on page 17.
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Step 3:  Prepare Your Velo 1 and Your
Desktop Computer for Velo 1 Application
Installation

Before you install Velo 1 applications, you must set the PC
connection on your Velo 1. Instructions for setting the connection
are below.

If you are an experienced user, you may want to set up your
Velo 1 and your computer to make the installation procedure go
much more quickly. Making these changes requires many more
steps, but greatly speeds up the installation process. If you choose
to make these changes, skip the instructions below (“To set the PC
connection on your Velo 1”) and follow the instructions on the next
page, “To increase the speed of data transfer between your Velo 1
and desktop computer.”

To set the PC Connection on your Velo 1
1 Make sure your Velo 1 is turned on.

2 Tap Start in the lower left-hand corner, tap Settings, then
tap Control Panel.

3 Double-tap Communications.

4 Tap the PC Connection tab.

5 Tap the Change button.

6 Under Connect to desktop computer using, select
Desktop @ 19200.

Important:   Even though Desktop @ 19200 is the default setting,
you still need to select it to make it active.

7 Tap  to close the PC Connection dialog box.

8 Tap  to save the Communications settings.

9 Go to “Step 4: Install Velo Applications From the Velo 1
Upgrade CD” on page 20.

Step 3: Prepare for Velo 1 Application Installation
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To increase the speed of data transfer between your
Velo 1 and desktop computer
1 Disconnect the Velo 1 from the desktop computer.

2 On the Velo 1, tap Start, tap Programs, tap
Communication, then tap Remote Networking.

3 Double-tap Make New Connection.

4 Under Type a name for the connection, type a name
(such as “Fastest”), then tap Next.

5 Tap Configure, and then in the Baud Rate list, select the
desired rate (typically 115,200 baud is the fastest), then
tap .

6 Tap Finish. Tap x to close the window.

7 Tap the Start menu, tap Settings, then tap Control
Panel.

8 Double-tap Communications.

9 Select the PC Connection tab, then tap Change.

10 Under Connect to desktop computer using, select
the connection you created above.

11 Tap , then tap  again to close the Communications
control panel. Tap x to close the window.

12 Reset your Velo 1 (tap Start, tap Run, type reset, then
tap ). In the Reset Velo 1 dialog box, tap Yes.

13 On your desktop computer, open the Mobile Devices
window. In the File menu, click Communications, clear
Enable mobile device connection and click Apply.

14 If you are using Windows 95, go to step 15. If you are using
Windows NT, go to step 16 on the next page.
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15 If you are using Windows 95:

a On your desktop computer, click Start, point to
Settings, click Control Panel, then double-click the
System icon.

b Click the Device Manager tab, double-click Modem,
then select the port to which your Velo 1 is connected.

c Click Properties, click the Modem tab, and then under
Maximum speed select the same rate you specified on
your Velo 1. Tap  to close the window.

d Click OK, then click OK again to close the System
Properties dialog box. Tap  to close the window.

e Go to step 17 below.

16 If you are using Windows NT:

a On your desktop computer, click Start, point to
Settings, then click Control Panel.

b Double-click the Modems icon.

c Select Dial-Up Networking Serial Cable between 2
PCs, then click Properties.

d Set the Maximum speed to the same rate you
specified on your Velo 1, click OK, then click Close.

e Go to step 17 below.

17 In the Mobile Devices window, open the File menu, click
Communications, select Enable mobile device
connection, and click Apply.

18 Close all desktop programs and restart your computer.
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Step 4: Install Velo 1 Applications From
the Velo 1 Upgrade CD

The Philips Velo 1 Upgrade compact disc includes programs and
components of the Velo 1 applications and operating system. You
must install these components to ensure that all features of your
Velo 1 will function as intended. To install these programs from
the CD, follow these steps:

1 Connect the Velo Dock’s cable to the desktop computer’s
serial port.

2 Plug the AC power adapter into the DC jack on your Velo
Dock.

3 Place your Velo 1 in the Velo Dock and firmly slide the
H/PC until it snaps into place and the green light comes
on. Open the lid of the Velo 1 and make sure it is on.

4 In My Computer (on your desktop computer), browse to
the Mobile Devices folder and double-click the Velo 1
icon to start Windows CE Services 2.0.

Note: The first time you connect your Velo 1, Windows CE Services
2.0 may prompt you to select a communications port. Select the port
to which your Velo Dock or serial cable is connected, and make sure
the port speed is set to the speed you set your Velo 1 to in “Step 3:
Prepare Your Velo 1 and Your Desktop Computer for Velo 1 Application
Installation.”
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Step 4: Install Velo Applications

 5   The first time you connect your Velo 1, you will be
prompted to establish a new partnership. Accept the the
default choices until you see the screen for ActiveSync.
Uncheck (disable) the box that says “Enable
synchronization.” Click Next. Click Finish. You know you
are “partnered” when your Velo 1 icon appears in the
Mobile Devices folder window. If the icon does not
appear, select Refresh from the View Menu.

 6 Insert the Philips Velo 1 Upgrade compact disc into the CD-
ROM drive on your desktop computer.

The installation program starts automatically. If the
installation program does not start automatically, click
Run on the Start menu, and then type d:setup (where d:
is the letter of the drive containing the Philips Velo 1
Upgrade compact disc) and press Enter.

Note: The installation program uses your desktop computer’s Internet
browser. If you do not have a browser installed on your desktop
computer, install Microsoft Internet Explorer from the Philips Velo 1
Upgrade compact disc.

7 In the installer window, click Install Velo 1 Upgrade.

8 Read the Welcome screen, then click Next to proceed
with installation.

9 Follow the instructions on screen to complete software
installation.

Caution:  While the Philips Velo applications are being installed, do
not reset your Velo 1.

Note: The installer will ask if your Velo 1 has at least 12 MB of RAM.
If it doesn’t, when the installer tells you to install additional RAM,
follow the instructions on page 12.

10 When the installer asks if you want to install “PMGC
non-removeable items using the default application
install directory,” click Yes.
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Note: The installation of the applications can take a while. If you
leave your system, be sure to keep checking the status. If you leave
it too long the installation will fail (the program will time-out) and
you will have to start over. When setup is complete, you’ll see a
message on your desktop computer.

11 When you see a message on your Velo 1 asking “Would
you like to replace the existing file?” tap Yes to all. This
step installs the latest updates on your Velo 1.

12 When you see the “Reset Velo 1?” message on your Velo 1,
tap Yes.

13 Navigate to the Mobile Devices Window on your desktop
computer and open it. Select your Velo 1. Open the Tools
menu, and choose ActiveSync Options.  Check (enable)
the box that says “Enable synchronization” and click .

14 If you are upgrading your Velo 1 with the upgrade kit, go to
Step 5 on the next page to retrieve your data.

If you purchased your Velo 1 with 12 MB of DRAM and the
Microsoft Windows CE 2.0 Upgrade Card already installed,
go to the section “Using your Velo 1” on page 25.
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Step 5: Retrieve Your Data

You must complete this step only if you purchased the Microsoft
Windows CE 2.0 Upgrade Kit and you saved Velo 1 data as
instructed in Step 1.

After you’ve established the partnership between your Velo 1 and
desktop computer, you can restore the files and PIM data that you
backed up before upgrading.

Files — You can now restore individual files by moving files and
folders from your desktop computer to your Velo 1.

To restore individual files
1 Connect your Velo 1 to your desktop computer.

2 In My Computer, browse to the Mobile Devices folder
and double-click the Velo 1 icon.

3 Browse to the folder you created during the backup
procedure, and drag individual files to the Mobile Devices
window, or use the Cut and Paste commands to move
the files from the backup folder to your Velo 1.

Caution:   Do not use the Windows CE Services Restore function to
restore data after installing the Velo 1 applications and other components
from the Philips Velo 1 Upgrade compact disc..

Programs — You will need to reinstall any programs you’ve
added to your Velo 1 from the original source. In some cases,
existing programs may not be compatible with Windows CE 2.0.
Check with the program’s manufacturer to find out if you need a
new version.

Settings — Program and device settings, such as TCP/IP and
network settings for remote connections, settings for Inbox
services, alarms and reminders, desktop patterns, and sound
schemes must be restored manually. You will need to start each
program or open the control panel to restore any options you had
set previously.

Step 5: Retrieve Your Data
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PIM data — Calendar, Contacts, and Tasks data can be restored to
the new Pocket Outlook™ databases by synchronizing your Velo 1
with Microsoft Schedule+ or Microsoft Outlook on your desktop
computer. (If you chose to have the New Partnership Wizard
synchronize Calendar, Contacts, and Tasks data when you first
connected your upgraded Velo 1 to your desktop computer, your
Pocket Outlook data has already been restored, and you can skip
this section.)

To synchronize Pocket Outlook
1 Connect your Velo 1 to your desktop computer.

If you have set Windows CE Services 2.0 to synchronize on
connecting, synchronization will take place automatically.

2 If you have not set Windows CE Services 2.0 to synchronize
on connecting, on your desktop computer, open the
Mobile Devices folder (in My Computer) and double-click
the Velo 1 icon.

3 In the Mobile Devices window, click Synchronize Now
on the Tools menu.

Mail messages — If you have Microsoft Exchange or Outlook on
your desktop computer, you can transfer messages to your Velo 1,
using the Inbox Transfer extension in Exchange or Outlook.

To transfer mail messages
1 Connect your Velo 1 to your desktop computer.

2 In Microsoft Exchange or Outlook on your desktop
computer, select the messages you want to transfer.

3 On the Tools menu, click H/PC Inbox Transfer.

4 Under Transfer messages to your H/PC, select the
folder you want the messages saved in.

5 Click OK.

Note: The original dates and times of the messages you transfer will
be changed to the date and time at which the messages were
transferred.
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Using Your Velo 1

The Setup Wizard leads you through a few simple setup procedures,
such as calibrating the touch screen; setting the date, time, and time
zone; and storing personal information such as your name, address
and telephone number. To start the Setup Wizard, tap Start, select
Run, type in welcome, and press Enter.

You can change these settings at any time. For more information,
see Windows CE Help. To access Windows CE Help, tap Help on
the Start menu or tap ? on the title bar. When you open Help,
you’ll see topics for the application or system component you are
using. To see a list of all the Help contents, tap Other Help.

What’s on Your Velo 1?

Your Velo 1 uses Microsoft Windows CE, which is based on the
Microsoft Windows 95 operating system. It includes familiar
components such as the Start button and Start menu, taskbar,
desktop, browser, menu bar and toolbar, Control Panel, and
shortcuts.

Your Velo 1 also includes programs for your Velo 1 that help you
manage your schedule, retrieve and store information,
communicate with others via e-mail, and explore the World Wide
Web. These programs work alone and in conjunction with your
desktop computer. You can synchronize Schedule+ information
and transfer files between your handheld PC (H/PC) and your
desktop computer to ensure you’re always working with current
information.
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Windows CE 2.0

Some of Windows CE 2.0’s features are summarized below. For a
complete description of the features and detailed instructions, refer
to Windows CE Services Help. You can also download a Guided
Tour from Microsoft’s Web site: www.microsoft.com/WindowsCE.

◗ Address bar — The Windows CE Address Bar displays the full
path of the folder you’re viewing in Explorer view and lets
you quickly select recent folders from a drop-down list.

◗ Calculator — Perform calculations using on-screen buttons
and keep track of calculations with an on-screen “paper
tape.” In addition, you can copy data and paste it into
documents and spreadsheets.

◗ Graphic formats — Windows CE 2.0 supports .bmp files,
the same bitmap file format used by Windows 95. Bitmap
files can be transferred to your Velo 1 without conversion.

◗ Help — The Windows CE Help system includes detailed
procedures and instructions for all major programs.

◗ Inbox — Send and receive Internet mail, and send faxes. If
you have MicroBurst Virtual Courier™ Personal Edition on your
desktop computer or company file server, you can also access
cc:Mail™ and Microsoft Mail accounts. And if you’re running
Microsoft Exchange on your desktop computer, you can
transfer messages between your H/PC and desktop computer.

◗ Information Manager for Windows CE — Track contacts,
manage your schedule, and organize tasks. In addition, you
can set reminders to ensure you never miss an important
appointment.
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◗ Office — The Pocket Office group includes Pocket Word and
Pocket Excel, as well as an H/PC version of the popular
presentation program Microsoft PowerPoint.

• Pocket Word — Take notes, compose memos, and
review reports anytime, anywhere. You can create and edit
files in Pocket Word, and then transfer them to Microsoft
Word for printing. Includes the Zoom feature, which lets you
control the size of the document display, and a spelling
checker to help catch any mistakes.

• Pocket Excel — Calculate expenses, create reports, or
manage data. In addition, you can track an investment return
or keep an up-to-date mileage log while you’re on the road.
Includes Split Pane and Freeze Pane views as well as the
Zoom feature so that you can display specific areas of your
spreadsheets and control exactly what you see on the
screen.

• Pocket PowerPoint — Lets you use your Velo 1 to view
presentations created on your desktop computer. You can
display and edit presentations on the Velo 1 screen, or
connect to a VGA monitor using an optional V-Module and a
VGA PC Card.

◗ Pocket Internet Explorer version — View the wide range
of information available on the Internet.

◗ Pocket Outlook — Pocket Outlook integrates the Calendar,
Contacts, and Tasks applications with each other and with
the Inbox program on your Velo 1. The components work
together, so when you schedule a meeting with Calendar,
you can automatically send e-mail reminders to all attend-
ees, using Inbox and Contacts. You can also use the Go
menu to quickly switch between components. And you can
synchronize your Calendar and To-Do lists with Outlook or
Schedule+ on your desktop computer.

◗ Start menu — The Windows CE Start menu organizes your
programs into groups that make it faster to find the programs
you need. The Start menu also features cascading menus,
much like Windows 95.
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◗ Taskbar controls — You can hide the taskbar to increase the
screen area and view more of your documents or calendar. To
set taskbar options, point to Settings on the Start menu, and
tap Taskbar.

◗ World Clock — Keep track of the current date and time
whether you’re at home or away. You can set the clock to
keep time for your home city and for a place you’re visiting.
World Clock stores information on time zones, airports,
dialing codes, and distances, and even calculates sunrise and
sunset for any city in the world.

Other software

Your Velo 1 also includes several other programs. All preinstalled
programs are accessible from the Start menu, in the program
groups described below:

Velo 1 Applications

◗ bFAX Pro and bView — These two full-featured programs
from bSquare™ Development enable you to fax documents
from your Velo 1 and to view faxes you receive from others.
Use bFAX Pro for sending and receiving faxes and bView for
previewing and adjusting the appearance of documents
before they are faxed. You can also use bFAX Pro to send
documents created in other programs on your Velo 1, such
as Pocket Word (.pwd) files, H/PC bitmap (.2bp) files,
received fax (.tif) files, and ASCII text (.txt) files. You can
customize bFAX Pro by setting options for your cover page
and page layout.

◗ Characters — Use the Characters program to enter charac-
ters or symbols and characters not available on the key-
board. Select a font from the drop-down list to display the
complete character set for that font, then select and copy
characters directly into other programs such as Pocket Word
documents or e-mail messages.

◗ Reset — The Reset program (reset.exe) provides a reliable
method for resetting your Velo 1, while preserving your data
after you restore data from your desktop computer or when
the operating system stops responding to your commands or
stylus taps. There are several methods for resetting, depend-
ing on the severity of the problem, but you should try the
Reset program first.
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◗ AllPen® Mobile Forms Database — This program helps
you organize information on your Velo 1 and share that
information with your desktop computer. AllPen Mobile
Forms Database lets you create, modify, and customize a
database. After you have entered information into a personal
database, you can update, sort, search, and manage your
database with your Velo 1. You can view stored records, one
record at a time or in a List view that shows all the records
in the database. You can sort the information in your
database or list all records that contain some piece of text in
one of the fields. The information in the database is always
saved in the Database folder on your Velo 1.

◗ Unit Conversion — Use the Unit Conversion program to
convert between English and metric units for distance,
volume, weight, and temperature or to convert currency
between many international monetary units. When convert-
ing currency, you can use the approximate exchange rates
provided, or enter a more current exchange rate.

◗ Voice Memo — Record and manage spoken memos and
other sounds, without even opening your Velo 1. The button
on the lid provides convenient one-touch recording any-
where, whether you are walking down the street or sitting
on the train. After you have recorded a voice memo, you
can play it back, file it, or delete voice memos you no
longer need. Use the Audio Levels control panel to set input
and output levels for the Voice Memo program and to
change settings that affect the quality and size of the voice
memos you record.

Communication

◗ ActiveSync — ActiveSync enables you to connect to one or
more remote computers and synchronize your calendar,
tasks, contacts, and mail messages between Pocket Outlook
on your Velo 1 and Microsoft Outlook or Schedule+ on the
remote computer. You can also synchronize files in the
Synchronize Files folder on your Velo 1 with files in the My
Documents or Personal folder on your desktop computer.

◗ PC Link — The PC Link program manages the connection
between your Velo 1 and desktop computer. Use PC Link to
connect or disconnect or to check the status of the current
connection.

Using Your Velo 1
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Tips for Using Your Velo 1

• Press the Power button to turn your H/PC on and off. If you go
several minutes without working on your Velo 1, it will preserve
your work and suspend itself, shutting off automatically. Just press
the Power button to start working right where you left off.

• You should use the supplied stylus to touch the screen. There’s no
harm in using your fingertip, but many features require the stylus for
finer pointing.

Warning:  Don’t use sharp implements, such as keys or pens, to
touch the screen. These objects can damage the screen.

• The Velo 1 includes a built-in modem for connecting to a
telephone line. You can use the modem to explore the Internet,
send and receive e–mail, send faxes, and connect to other
services. Simply plug a standard telephone line into the RJ-11 jack
to the left of the screen (see the figure on page 37).

Note: The built-in modem is designed for use only in the U.S. To use
the built-in modem on your Velo 1, you must select Internal modem
on COM 4 when creating a new dial-up connection.
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Alarm Indicator Light (yellow)

Microphone

Backlight
button

RJ-11
phone jack

Power
button

Latch

Stylus

Serial Connection Light (red)

Recharging Indicator Light (green)

Reset button

Contrast dial

Velo 1 with lid open

Indicator lights
• The green recharging indicator light turns on if your recharge-

able battery pack is being recharged by your Velo Dock or an
AC power adapter. The green light turns off when charging is
complete.

• The red serial connection light blinks when your Velo 1 is
connected to a desktop computer with Windows CE 2.0
Services (or other serial connection) and a software connec-
tion has been established.

• The yellow alarm indicator light blinks to indicate an alarm
you have set. This light stops blinking when you tap  to
close the alarm’s dialog box or double-tap the alarm icon in
the status area of the taskbar.
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Battery tips

The Velo 1 has two kinds of batteries:

◗ Main batteries power your H/PC during normal mobile use.

◗ The backup battery provides enough power to keep your data
safe if no other power source (main batteries or external
power) is available. The backup battery was installed at the
factory, but it must be activated before it will protect your
data.

You can run your Velo 1 virtually anywhere on battery power. If
you’re close to an AC power outlet, you can connect to the power
adapter that is supplied with your Velo 1.

Protecting your data during low power

If you are using AA batteries, do not remove these batteries from
your Velo 1 until you are ready to replace them with fresh
batteries. Even when AA batteries are too low to turn on the H/
PC, they may still have enough power to protect your saved data
for more than a week.

If you remove the main batteries, the backup battery will maintain
your data for one or two days; however, to ensure maximum
protection, you should leave the main batteries installed and
replace them with a fresh pair as soon as possible.

RJ-ll phone jack

Serial connector

DC jack

IR port

Side view of Velo 1 (left side)
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To replace the backup battery

When you see a message that you need to replace the backup
battery, follow these steps:

1 Make sure the main batteries are working, or plug the
Velo 1 into a wall outlet with the supplied AC power
adapter.

2 Remove the screw from the backup battery door, then
remove the door and the old battery.

3 Insert a CR2032 (or equivalent) lithium coin cell backup
battery.

The side marked with a + (plus sign) faces up.

4 Replace the backup battery door and the screw.

To connect to external power

Warning:   Use only Philips power adapters designed specifically for
use with the Velo 1; otherwise you may damage your H/PC.

1 Plug the power adapter into an AC power outlet.

2 Plug the AC power adapter into the DC jack on either
your Velo 1 or Velo Dock.

If the rechargeable battery pack is installed, the batteries will be
recharged while your H/PC is connected to AC power.

Note:  If the rechargeable battery pack is installed, the first time you
connect your Velo 1 to AC power you should fully charge the battery
pack before you disconnect the AC power adapter. Charging takes about
two and a half hours. While the battery pack is charging, the green
recharging indicator light is on. The light turns off when charging is
complete.

Using Your Velo 1
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Resetting your Velo 1

Occasionally, you will need to reset your Velo 1, for example, after
you restore data from your desktop computer or when the
operating system stops responding to your commands or stylus taps.
There are several methods for resetting, depending on the severity
of the problem. In most cases, you can reset your Velo 1 without
losing any data; however, to ensure the safety of your information
you should regularly back up your data to your desktop computer.

In general, the Reset program (reset.exe) is the most reliable
method for resetting your H/PC while preserving your data. The
Reset program is in the Velo Applications folder on your Velo 1.

To reset your Velo 1 using the Reset program
 1 On the Start menu, tap Run.

 2 In the run dialog box, type reset, and then tap OK.

 3 In the Reset Velo 1 dialog box, tap Yes.

Important: Only when the Reset program fails to correct a problem
should you press the Reset button with the stylus. Pressing the Reset
button once should retain the data stored on your Velo 1; however,
pressing the Reset button multiple times will cause your Velo 1 to do a
full restart, erasing all information.

In the most severe cases, when your Velo 1 doesn’t respond to the
Reset button or if you forget your password, you may need to
perform a full restart by removing all power, including the main
and backup batteries, from your Velo 1. Resetting in this way
erases all files you’ve saved and all programs you’ve installed on
your Velo 1. If you perform a full restart, you will have to reinstall
the software on the Philips Velo 1 Upgrade CD.
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Frequently Asked Questions

The following information provides answers to questions that are
frequently asked by users when setting up their H/PCs for the first
time.

Q: How much total memory is available on my H/PC?

A: In the System control panel, tap the General tab to view
system information, including the total installed DRAM memory
(this does include DRAM Miniature Cards.

Q: How do I know how much free storage space I have on my
H/PC?

A: In the System control panel, tap the Memory tab to view how
much storage and program memory is in use. Move the slider to
allocate more memory for either programs or storage.

Q: What does the ÿ key do?

A: It performs the same function as the Windows key found on
newer PC keyboards.

Use this key combination To perform this function

ÿ Open Start menu

ÿ +K Open Keyboard control panel

ÿ +I Open Stylus control panel

ÿ +C Open Control Panel

ÿ +E Explore My Handheld PC

ÿ +R Display the Run dialog box

ÿ +H Open Windows CE Help

CTRL+ ÿ +A Select All on desktop

Q: How do I minimize a document or application?

A: Tap the application button on the taskbar.

Using Your Velo 1
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Q: How do I turn on CAPS LOCK?

A: Press both SHIFT keys at the same time. When CAPS LOCK is on,
 appears in the toolbar.

Q: How can I check my battery power?

A: Double-tap the power icon in the control panel.

Q: How do I “right-click”?

A: Not all H/PC applications support the right-click. In the Windows
CE Explorer, press and hold down the ALT key while you tap an
item.

Q: Does  work the same as in Windows 95?

A: When the  button appears on the toolbar, tapping  will close
a window without saving changes.

Q: How do I print documents on my H/PC?

A: You can print documents directly from your H/PC with the
proper connection to a printer or from Windows CE Services on
your desktop computer.
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Quick Start keys

The Velo 1 provides Quick Start keys, a fast way to use the
keyboard to go to many of your favorite programs.

To use a QuickStart key to start a program, hold down the ALT
key and press one of the number keys. The following table lists
the Quick Start keys you can use:

Quick Start keys Program started

ALT + 1 Pocket Word

ALT + 2 Pocket Excel

ALT + 3 Calendar

ALT + 4 Contacts

ALT + 5 Tasks

ALT + 6 Pocket Internet Explorer

ALT + 7 Inbox

ALT + 8 Database

ALT + 9 Calculator

ALT + 0 Voice Memo

You can use the Quick Start keys control panel to reprogram
QuickStart keys to open any application.

Cleaning and Maintaining Your Velo 1

Clean the casing of your Velo 1 with a damp cloth. For more
persistent dirt such as grease or oils, use a solution of a mild
detergent in water. Always wipe off your Velo 1 with a dry cloth
after cleaning.

To clean the touch screen, use a damp cloth or a premoistened
pad designed specifically for use on computer monitors.

Using Your Velo
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Using the built-in modem

The Velo 1 includes a built-in modem for connecting to a
telephone line. You can use the modem to explore the Internet,
send and receive e–mail, send faxes, and connect to other
services.

To connect to a telephone line
 1 Lift the RJ-11 jack away from the case, and plug in a

standard telephone line.

 2 The RJ-11 jack is to the left of the screen, in the center.

Note: The built-in modem is designed for use only in the U.S.

RJ-11 phone line connection

Note:  To use the built-in modem on your Velo 1, you must select
Internal modem on COM 4 when creating a new dial-up
connection.
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Hardware Specifications

Physical description Velo 1

Dimensions 6.75” (171 mm) by 3.75” (95 mm) by 1.25” (32 mm)

Weight 13.2 oz. (370 g) without batteries

Expansion

Velo Dock Provides connection to desktop computer and
external power supply.

Begins synchronization if software is running
on desktop computer.

Recharges batteries with battery pack installed.

Power

Main batteries Requires 2 AA alkaline or lithium batteries or
1 NiMH rechargeable battery pack

Backup battery Requires CR2032 lithium coin cell

DC jack 12V @ 500mA

Processor and basic input/output

Keyboard 61-key QWERTY layout

Quick Start keys to start applications

Display Backlit, nonglare, touchscreen display

Grayscale LCD (480x240 pixels, .24mm dot pitch, .23mm dot size)
with contrast dial and on-demand backlighting

CPU 3.3V 32-bit MIPS R3910 RISC processor
@ 36.864 MHz

Other input/output

Serial port RS-232 serial port
Supports data transfer rate up to 230 Kbps

Infrared Meets IrDA standard (Level 1)
transceiver Data transfer rate up to 115Kbps

Hardware Specifications
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Indicator lights Green light indicates charging of
the rechargeable batteries

Red light indicates communication over
the Serial connector

Yellow light indicates alarms or messages

Audio in Omnidirectional microphone used in conjunction
with Voice Memo application

Records up to 16 minutes per Mbyte using
TrueSpeech™ 8.5 sound compression

Audio out Speaker on the bottom can play standard .wav
files with sample rates:

8 kHz, 8 or 16 bit mono

11 kHz, 8 or 16 bit mono

11.025 kHz, 8 or 16 bit mono

22 kHz, 8 or 16 bit mono

22.050 kHz, 8 or 16 bit mono

Communication

Modem Built-in 19.2 Kbps V.32/bis/ter data/fax modem

Compatible with ITU-T standards.

Data modes:

V.32 ter (adaptive rate 4800 - 19200 bps)

V.32 bis (adaptive rate 4800 - 14400 bps)

V.32 (adaptive rate 4800 - 9600 bps)

V.23 (1200 bps downstream, 75 bps upstream)

V.22 bis (2400 bps)

V.22 (1200 bps)

V.21 (0 - 300 bps)
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Fax modes (group 3, class 1):

V.29 (7200 bps, 9600 bps)

V.27 ter (2400 bps, 4800 bps)

Data link layers:

Async and HDLC framers

V.42 LAPM (error correction), not including MNP

Telephone line Low-profile RJ-11 jack connector

Expansion

Velo Dock Provides connection to desktop computer and
external power supply.

Begins synchronization if software is running
on desktop computer.

Recharges batteries with battery pack installed.

Miniature Card Two industry-standard expansion slots for DRAM,
slots Flash memory, or ROM upgrades.

Type II PC Contains one PC card slot (Type II PCMCIA),
card power specification: V

cc
= 5V @ 325mA, V

pp
= 5V.

V-Module
(optional)

Hardware Specifications
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Regulatory Information

Declaration of Conformity

This device complies with Part 15 of the FCC rules. Operations is
subject to the following two conditions: (1) This device may not
cause harmful interference, and (2) This device must accept any
interference received, including interference that may cause
undesired operation.

Responsible Party Name Philips Mobile Computing Group

Telephone 1-888-275-8356

Product/Model Velo 1

FCC Warning Statement

This equipment has been tested and found to comply with the limits
for a Class B digital device, pursuant to Part 15 of the FCC Rules.
These limits are designed to provide reasonable protection against
harmful interference in a residential installation. This equipment
generates, uses and can radiate radio frequency energy. If not
installed and used in accordance with the instructions, it can cause
harmful interference to radio communications. However, there is no
guarantee that interference will not occur in a particular installation.
Determine if the equipment does cause interference to radio or
television reception by turning the equipment off and on. The user
is encouraged to try to correct the interference by one or more of
the following measures:

1 Where it can be done safely, reorient or relocate the
receiving antenna.

2 Increase the separation between the equipment and
receiver.

3 Connect the equipment into an outlet on a circuit
different from that to which the receiver is
connected.

4 Consult the dealer or an experienced radio/TV
technician for help.
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Changes or modifications not expressly approved by the
manufacturer could void the user’s authority to operate the
equipment. Shielded interface cables must be used when
operating this device or the user’s authority to operate this
equipment could be voided.

Telephone Consumer Protection Act of 1991

The Telephone Consumer Protection Act of 1991 makes it
unlawful for any person to use a computer or other electronic
device to send any message via a telephone facsimile machine
unless such message clearly contains, in a margin at the top or
bottom of each transmitted page or on the first page of the
transmission, the date and time it is sent and an identification of
the business, other entity, or individual sending the message and
the telephone number of the sending machine or such business,
other entity, or individual.

FCC PART 68 Requirements

This equipment complies with Part 68 of the FCC rules. On the
back of the computer is a label that contains, among other
information, the FCC registration number and ringer equivalence
number (REN) for this equipment. If requested, this information
must be provided to the telephone company.

This equipment uses the following USOC jack: RJ11C

The REN is used to determine the quantity of devices which may
be connected to the telephone line. Excessive REN’s on the
telephone line may result in the devices not ringing in response to
an incoming call. In most, but not all areas, the sum of the REN’s
should not exceed five (5.0). To be certain of the number of
devices that may be connected to the line, as determined by the
total REN’s contact the telephone company to determine the
maximum REN for the calling area.

If this equipment causes harm to the telephone network, the
telephone company will notify you in advance that temporary
discontinuance of service may be required. If advance notice isn’t
practical, the telephone company will notify the customer as soon
as possible. Also, you will be advised of your right to file a
complaint with the FCC if you believe it is necessary.

Regulatory Information
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The telephone company may make changes in its facilities,
equipment, operations, or procedures that could affect the
operation of the equipment. If this happens, the telephone
company will provide advance notice in order for you to make
the necessary modifications in order to maintain uninterrupted
service.

If trouble is experienced with this equipment, please contact
Philips Mobile Computing Group at 1-888-275-8356 for repair and
(or) warranty information. If the trouble is causing harm to the
telephone network, the telephone company may request you
remove the equipment from the network until the problem is
resolved.

This equipment cannot be used on telephone company-provided
coin service. Connection to Party Line Service is subject to state
tariffs.

This equipment is designed to be connected to the telephone
network or premises wiring using a compatible modular jack
which is FCC Part 68 compliant.

Canadian IC CS-03 Requirements

Notice: The Industry Canada label identifies certified equipment. This
certification means that the equipment meets certain
telecommunications network protective, operational and safety
requirements as prescribed in the appropriate Terminal Equipment
Technical Requirements document(s). The Department does not
guarantee the equipment will operate to the user’s satisfaction.

Before installing this equipment, users should ensure that it is
permissible to be connected to the facilities of the local
telecommunications company The equipment must also be
installed using an acceptable method of connection. The customer
should be aware that compliance with the above conditions may
not prevent degradation of service in some situations.

Repairs to certified equipment should be coordinated by a
representative designated by the supplier. Any repairs or
alterations made by the user to this equipment, or equipment
malfunctions, may give the telecommunications company cause to
request the user to disconnect the equipment.
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Users should ensure for their own protection that the electrical
ground connections of the power utility, telephone lines and
internal metallic water pipe system, if present, are connected
together. This precaution may be particularly important in rural
areas.

Caution: Users should not attempt to make such connections
themselves, but should contact the appropriate electric inspection
authority, or electrician, as appropriate.

Ringer Equivalence

The Ringer Equivalence Number (REN) of this device is 0.6B.

Notice: The Ringer Equivalence Number (REN) assigned to each
terminal device provides an indication of the maximum number of
terminals allowed to be connected to a telephone interface. The
termination on an interface may consist of any combination of devices
subject only to the requirement that the sum of the Ringer Equivalence
Numbers of all the devices does not exceed 5. The equipment uses a
CA11A jack.

Regulatory Information


